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The Lorain Public Library and LCCUG are co-sponsoring a new computer series
on the third Wednesday of each month

Computer Coffee Klatch
Read about
New
Coffee Klatch

Wednesday - August 20, 2008 at 10 AM in the new media room at the

Lorain Public Library
We ask that you register for this program by calling 244-1192 ext. 272.

M o n t h l y M e e t i n g s H e l d A t G ou l d A u d i t o r i u m
2 nd F l o o r , S t. J o s e p h C o m m u n i t y C e n t e r , L o r a i n , O H
5:30 PM Doors Open With Outer Lobby Q & A Sessions
6:45 PM Meeting & Presentation Begins
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Lou Koch
vp_programs@lccug.com

Secretary

Don Hall
secretary@lccug.com

Treasurer

Micky Knickman
treasurer@lccug.com

Other than classes you can attend free through the Computer
Club and at the Public Library there are also classes for a fee
that you can take through the Lorain County Community
College or the Lorain County Vocational School.

Newsletter Editor

Pam Rihel
newsletter@lccug.com

Web Page Editor

Kaye Coller
webpage@lccug.com

But keep in mind that there are many classes available entirely online from your computer. Some of these require
tuition while many of them are free. Many times it depends
on whether the class actually offers college credit or just
enables you to learn a new skill.
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Director of
Membership

Edie Lewandowski
membership@lccug.com

One good way to get started with online classes is at http://
www.e4meohio.org/. Here you can start with a free noncredit course and experience what e-learning is all about
from the comfort of your own home. E 4 ME is fun and will
introduce you to e-learning. It is a month-long course and
you can complete it at your own pace. From here you can
discover hundreds of online courses that Ohio colleges offer
leading to certificates and degrees.
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Free Learning Opportunities
Learning new things keeps us young and lets us develop new
skills. This helps challenge our minds and makes life more
interesting. We in the computer club are particularly interested in learning new things about computers.

A new service that the Ohio public libraries are offering their
library patrons is access to Learn2. If an individual were to
go to learn2.com and sign up for access to these learning
opportunities, it would could them at least $20 per month.
With your library card you can access Microsoft Office
classes for free through your public Library website.
This service is part of the Learning Express collection of
tests (http://www.oplin.org/tests) that allow you to practice
for tests in many professional areas. This collection has been
enhanced with a set of computer skills tutorials from
Learn2.com. These tutorials appear under the heading
"Computer Skills" in the list of tests and use a combination
of audio, video, graphic animation, screen captures and text
to teach computer skills. Using these requires you to
download a free program that will enable you to use all the
features of this multimedia tool. You will be asked to sign up
and choose a password so you can stop and return to the site
again and resume where you were.
There is another website that is called "Learn Anything: 100
Places to Find Free Webinars and Tutorials". You can either
google this title to find this site or go to
http://
www.collegeathome.com/blog/2008/06/17/learn-anything100-places-to-find-free-webinars-and-tutorials.
Here you will find a large list of websites with training in
everything from Music, Science, Do-it-yourself, languages,
computers, etc.
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The Virtual University (http://vu.org/) is the Internet's oldest
learning community and a pioneer in Web-based education!
Since 1995, more than two million learners from 128 countries have attended classes at their global village campus!
Classes here cost a small fee and cover areas such as Computers, writing, and healing and self-discovery.
Another way to find online tutorials is to Google the subject
that you are looking for. For instance you might type "Paint
Shop Pro layers - tutorial" OR "How to cook a soufflé" into
Google and have a large list of resources returned to you.
Many simple things can be learned effectively by being demonstrated with a virtual tutorial on YouTube. For instance
you might go to YouTube.com and search "How to change a
tire" or "how to tie a tie".
There doesn't seem to be a limit to what you can learn online.
Check out these learning opportunities and jump in and learn
a new skill!!
Sandee
August 2008 | Interface

No Regular Meetings on the
2nd & 4th TUESDAYs at Gould Auditorium
in August 2008

No Meetings At Gould In

We’re On

The Lorain Public Library and LCCUG are co-sponsoring a new computer series
on the third Wednesday of each month

Computer Coffee Klatch
Wednesday - August 20, 2008 at 10 AM - in the new media room at the
Lorain Public Library
Join us for coffee and an introduction to Interesting Websites. Get your questions answered in a friendly atmosphere.
This meeting will be an informal gathering for those who want to learn more about computers the fun and easy way.
Join us for an information gathering as we explore and demonstrate how to use a computer.

We ask that you register for this program by calling 244-1192 ext. 272.
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Executive Board
Meeting Minutes

General
Meeting Minutes

JULY 1, 2008

JULY 8, 2008

Attending were Sandee Ruth, Don Hall, Micky
Knickman, Kaye Coller, Edie Lewandowski, Ken
Ritchey and Vince Traina.

President Sandee Ruth called the meeting to order. A
motion to accept the minutes as shown in the May issue of the interface on our web site was made by Edie
Lewandowski, seconded by Micky Knickman. Motion
passed.

The club will buy out the Sept. 18th performance of the
Workshop Players, ―Lying in State‖. Tickets will be sold
for $12.00 due to our cost increase.
The board agreed $25 should be given to the security
guard at St. Joes for his action in saving the club’s
laptop computer the evening of June 27.
Ken gave a rundown on signups for the annual picnic.
The board agreed to give two $50 raffle prizes to adult
registrants to the picnic. Edie will send out an Ediegram
on the picnic. Kaye will try to get three restaurant
coupons as prizes for bingo winners.
The board agreed to cancel the officers meeting, the
two Gould meetings and the Problem Solving
Workshop in August, 2008.
Kaye moved we give $50 along with a mug showing
the club’s new logo to the designer for his work on the
new club logo. Edie seconded, motion passed.
Edie will check with Royal to see if a discount for club
members can be obtained. We would like to give our
sponsors a link on page 1 of our web site.
Sandee suggested we take photos of people attending
meetings along with their names. These would be
shown at future meetings prior to the actual meeting.
Vince moved, Kaye seconded, to adjourn the meeting.

Term Of The Day: July 17, 2008

off-peak
Used to describe times when network activity is at a
minimum. Off-peak hours typically include evenings
and weekends. Mobile phone companies often provide
a greater amount of free off-peak minutes than peak
minutes and may charge less for additional off-peak
minutes compared to peak minutes. Off-peak can also
describe the hours at which Internet traffic is at a minimum.
Reprinted with permission from Smart Computing. Visit
http://www.smartcomputing.com to learn what Smart Computing can
do for you and your user group!
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Keith Kuhn gave an example of a phony E-mail alert
by going to snopes.com for verification.
Sandee showed members how to delete the many addresses before forwarding an E-mail and how to send
to multiple addresses using BCC (blind carbon copy),
thus minimizing the possibility of spammers getting
your addresses.
Sandee continued to show some of the many web sites
she uses to find information. These varied from seeing
a photo of a street address to finding information on
movie stars to exchanging paperback books.
Elmer Myers won the money raffle, Ed Syrowski won
the first software/hardware raffle.
Keith Kuhn moved, Ken Ritchey seconded that the
meeting be adjourned.

You know you are a
Genealogy addict when....
.... You brake for libraries.
.... You hyperventilate at the sight of an old cemetery.
.... You would rather browse in a cemetery than a
shopping mall.
.... You would rather read census schedules than a
good book.
.... You are more interested in what happened in
1699 than in 1999.
.... Eenrum, Baflo and Groningen are household
names, but you can't remember what to call the
dog.
.... You store your clothes under the bed (or wear
the same two outfits to save space), because your
closet is full of books and papers.
.... All your correspondence begins with "Dear
Cousin".
.... You have traced every one of your ancestral
lines back to Adam and Eve, you have it documented and still don't want to quit.
.... Your most important social life is meeting people who you run into while searching a family line.
August 2008 | Interface

Genealogy Reviews Online,
http://
www.genealogyreviewsonline.com/
by Tim Agazio, provides ―news, reviews, and other
interesting items related to genealogy and history.‖ He
may include info about DNA & genealogy, what's happening on various genealogy websites, etc.
Kaye Coller caseycatnip@gmail.com

.

Genealogy Blogs
Blog: a journal that is available on the
web. The activity of updating a blog is
"blogging" and someone who keeps a
blog is a "blogger."
If you'd like to know how other people go about searching for their ancestors, you might want to check out
some of the many genealogy blogs available online.
You might find some new search techniques, what
some of the best genealogy websites are, or even learn
something you didn't know about history in general. I
couldn't begin to write about all the blogs I've discovered recently, but here are some I thought might be
worth your investigation.
Kimberly's Genealogy Blog
http://genealogy.about.com/b/
Kimberly is a professional genealogist who posts her blog on About.com. She writes
about what's happening on some of the commercial
websites, like FindMyPast.com,. She also gives tips to
help you gather your information hidden in your home.
It's a good blog to start with.
All My Ancestors
http://allmyancestors.com/blog/
This blog is about the writer’s search and what she's
found along the way. The stories are interesting even if
they don't pertain to your own family, but the valuable
thing about this blog is what you can learn about
searching and then making the information more than
just facts and statistics.

http://blog.rootsmagic.com/
My favorite genealogy program now has a blog. Of
course RM’s creator, Bruce Buzbee will be posting information about the new version due any time now, but
he’ll also be explaining how to use the new features
and other information helpful to genealogists. Check it
out. There’s not a lot there because it’s brand new, but
there will be soon, I’ll bet.

I n
order to find other genealogy blogs (and there are
many more than you might think), go to:
http://creativegene.blogspot.com/2006/06/aboutcarnival-of-genealogy.html You may be familiar with
Web Rings which link sites with similar interests. For
example, a number of people interested in scrapbooking link to each other to share ideas. A blog carnival is
more polished and informative. It's described as a type
of blog event. It is similar to a magazine, in that it is
dedicated to a particular topic, and is published on a
regular schedule, often weekly or monthly. Each edition
of a blog carnival is in the form of a blog article that
contains permalinks links to other blog articles on the
particular topic. If you check out the link to The Carnival
of Genealogy, you'll see many more blogs to look at.
You might even find someone who can help you break
down a brick wall or two.

Family Matters

http://moultriecreek.us/family/ The blogger, Denice
Olson, writes, ―Here you’ll find articles discussing online
search and research tricks along with tools, applications and services covering all aspects of family history
- from research to organization to preservation and
even publishing‖ I have a little trouble navigating this
one, but it's worth checking out. It's combined with her
website, Moultrie Creek which has some beautiful photos as well as other information.
August 2008| Interface
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Firefox 3 – Hot New
Browser
By Ira Wilsker, APCUG Director; Columnist, The Examiner, Beaumont, TX; Radio and TV Show Host
Iwilsker(at)apcug.net
WEBSITES:
http://www.getfirefox.com – Free Download
http://www.mozilla.com/en-US/firefox/features/ - Features
https://addons.mozilla.org/firefox/ - Add ons
After a lengthy wait, Mozilla has released the latest and
greatest release of the very popular web browser, Firefox 3. This new release, available for free download
from www.getfirefox.com, has many new features,
making it a very strong competitor to Microsoft’s ubiquitous browser, Internet Explorer.

Firefox evolved from an earlier browser, Mozilla, which
in turn grew out of the Netscape browser as AOL announced the cessation of Netscape development.
Since its first release several years ago, Firefox in its
current and previous versions has developed a wide
following, with hundreds of millions of copies
downloaded. The newly released version 3 has tentatively set a Guinness world record with over 8 million
copies downloaded in its first 24 hours of public release, despite overloaded servers that discouraged
countless people from downloading it the first day of
issue. According to published reports, the number of
copies of Firefox 3 downloaded surpassed 14 million
downloads in the first 72 hours. Obviously, many people are using it.
Rhetorically, so why are so many using Firefox 3 rather
than Internet Explorer (IE), which is installed by default
on all contemporary Windows computers? There are
several other fine browsers in circulation, such as the
newly released update to Opera, and Apple’s Safari
(for both Windows and Mac), but for Windows computers, Firefox is firmly in second place, right behind
Internet Explorer. If Internet Explorer was not preinstalled on Windows computers and integrated into the
operating system, there is a good chance that Firefox 3
could surpass IE in a fair competitive market. Firefox 3
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is faster rendering web pages than IE, has superior
tabbed browsing, is written in tighter code taking fewer
system resources, and has many advantages over IE.
There is no reason why PC users should not download
Firefox 3 for Windows (7.8mb download), and install it,
as it runs happily on computers that already have IE
installed. On a fresh installation of Firefox on a Windows computer, Firefox will nondestructively import the
favorites (bookmarks), cookies, and other information
from IE, without making any changes or impeding IE in
any way. If Firefox 3 is installed on a computer that has
an older version of Firefox installed, it will automatically
install it as an upgrade, including all bookmarks, passwords, cookies, and other information. Once installed,
many users, such as me, prefer to use Firefox instead
of IE. In my case I would say that I use Firefox for 98%
of my browsing tasks; it would be 100%, but I have IE
setup to access another internet account that I have,
but rarely use.
According to the Firefox 3 website at www.mozilla.com/

en-US/firefox, over 15,000 improvements were made to
version 3 over version 2. The newly released version 3
is claimed to be faster, safer, and smarter than the previous version, and also IE! One of the new features,
which I have personally verified, is the fact that web
pages do indeed load faster than on IE and previous
versions of Firefox. Firefox 3 also consumes less system memory and system resources, leading to improved computer performance when Firefox is loaded
and running, compared to the previous version, or even
IE. Firefox 3 is also more secure than previous browsers, and incorporates the latest technologies to help
prevent phishing (identity theft), and other website forgeries. A neat new feature in Firefox 3 is ―Instant Website ID‖, where clicking on the tiny website icon (―site
favicon‖) at the left of the URL in the menu bar will display site information and identification, which will likely
indicate if the site is as intended, or a web forgery.
Firefox 3 has also been engineered to work smoothly
and compliment Vista’s parental controls, as well as
most antivirus and other security programs.
Another interesting feature unique to Firefox 3 is the
―Smart Location Bar‖ that shows detailed information
(Continued on page 7)
August 2008 | Interface

(Continued from page 6) Firefox 3 Hot New Browser

on websites recently visited, and is accessed by clicking on the right side of the menu bar. This Smart Location Bar is intelligent, in that it adapts to persona preferences to locate better website matches. Typing a ―tag‖
or keyword in the menu bar opens a detailed list of previously visited websites containing that keyword, making it very fast and easy to locate websites that have
previously been visited. Another very useful feature is
the integrated spell checker, which underlines any misspelled words typed in a browser window; right clicking
on the word opens a list of suggested spellings, which
a mouse click will instantly replace the incorrect word
with the correctly spelled word.
Malware of various types, including worms, Trojans,
viruses, and spyware is a growing menace to internet
users. Firefox 3 integrates a sophisticated anti-malware
feature that provides some protection if the user either
intentionally or erroneously accesses a website that
contains attack code. If such a dangerous website is
accessed, a full screen (browser window) display will
appear as a warning. Firefox, working with other organizations (including Google) maintains a continuously updated list of so called ―attack sites‖, so there is
nothing for the user to update or maintain. In the event
the user does happen to fall into a suspect site, such
as a very freshly created phishing (identity theft) website, the forgery can be quickly reported by simply clicking on HELP – REPORT WEB FORGERY; this will
connect to a Google service that collects such information on a real-time basis, verifies the forgery, and automatically adds it to the malware list, as well as forwards
the information to groups like Phish Tank
(www.phishtank.com) for further action.
Many of us use multiple passwords and user names on
countless websites. Firefox 3 has an excellent integrated and secure password manager. When a password is first entered, Firefox 3 asks if you want it to remember that password and logon information, without
any annoying pop-ups. Speaking of pop-ups, Firefox 3
incorporates a sophisticated and easily configurable
pop-up blocker which can stop pop-ups and popunders, speeding and making more enjoyable the surfAugust 2008| Interface

ing experience. In some cases, pop-ups are not irritating advertisements, but instead contain important information; these can be easily allowed when desired.
Many of us choose to tweak the appearance and features of our browsers, and Firefox 3 happily obliges.
Firefox has many themes and ―personas‖ that can be
selectively implemented to change the appearance of
the browser to meet our individual tastes. For those of
us who want additional features, Firefox offers over
5,000 free ―add-ons‖ (addons.mozilla.org/firefox), which
are easy to install devices to customize the browser to
work as desired. I have installed about a dozen addons, including some security add-ons (PhishTank,
McAfee SiteAdvisor, and others), as well as an enhanced download manager (the one integrated in Firefox 3 is very adequate for most users). I also have selected to use differently colored tabs on the top of the
browser window, an add-on that can make a tab an IE
window (for the rare cases when a website is intended
for IE only), a PDF manager, and several other addons.
Firefox 3 is an outstanding and free product. It is a very
worthwhile competitor to Internet Explorer, and users
should try it to see if they like it. I like it, and use it almost exclusively on my desktop and notebook computers. That is the best recommendation I can give it.
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

365-2288 - Elyria

1-800-238-8973 - USA

591 Cleveland Street Elyria, Ohio 44035
COMPUTER REPAIR
PRINTERS & SUPPLIES
UPGRADES
* CUSTOM PC'S & LAPTOPS
* CALL FOR BEST PRICES
* EDUCATION DISCOUNTS
LCD MONITORS & TVS

Shop at

www.ROYALBUSINESS.com

and save $$$

Financing Available - 90 days same as cash
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For Anybody Who
Has Thought About
Trying Linux

and drivers necessary for your system. If you have
hardware that has proprietary drivers available, Linux
cannot include them in the CD for legal reasons. Ubuntu works around this by providing a Restricted Drivers tool that lists all such hardware found on your system and provides the ability to download and install
the necessary drivers in a click or two, legally.

By Drew Kwashnak, Linux SIG Leader, Danbury Area
Computer Society, CT
www.dacs.org
dacseditor(at)dacs.org

Now that you have Ubuntu up and running on your system, what can you do? Plenty! Ubuntu brings you a full
featured operating system complete with:

For anybody who has thought about trying Linux, it has
become easier than ever before with Ubuntu 8.04 LTS
Hardy Heron. As with most Linux distributions, Ubuntu
is available as a free download and is freely distributable. It is even available already installed on Dell computers. The most common method is downloading the
ISO image from Ubuntu's website (http://
www.ubuntu.com) and burning it onto a CD.
From the site, you can download the Desktop version
or Server for 32-bit and 64-bit systems. There is even
an option to download what is called an alternative version which is just the installer and does not include the
LiveCD portion, which also includes an installer. If you
are like me, until a couple months ago, and living on
dial-up or you do not have a CD burner handy or just
don't want to put in that much effort then you can order
a free CD through the corporate sponsor of Ubuntu,
Canonical, ShipIt department.
I have been very
pleased with the speed with which their CDs arrive.
Alternatively, the website contains links to vendors
where you can buy the CDs from under $5 to more,
and they can handle large orders as well.
Once you have your CD in your hot little hands, trying
Ubuntu is as simple as placing it in your CD-ROM tray
and rebooting your system. The system will boot from
the CD and after a short moment you’ll be greeted with
the Ubuntu welcome screen. If you want to ―try before
you buy,‖ then you can choose the default ―Try Ubuntu
without any changes to your computer‖ and your hard
drive will not be touched during your session unless
you choose to. You don’t even need a hard drive to
select this option; you just will not be able to install it
from the session.
If you are more certain or just daring then you can go
straight into the installer and in about 60 minutes (45
minutes if you know what you are doing) you’re booting
to your new Ubuntu installation.

• Firefox 3.05 beta web browser
• OpenOffice.org 2.4 full featured office suite
compatible with pre-Office 2007 Word, Excel,
PowerPoint and some Access files.
• Evolution personal information manager for
email and calendar goodness, a Microsoft Outlook user can feel comfortable with. There are
even plug-ins to allow Evolution to access existing Microsoft Exchange servers.
• Pidgin multi-protocol instant messenger including Yahoo, MSN, AIM, Jabber, IRC and more.
• Gimp (GNU Image Manipulation Program), a
powerful Photoshop-like image editing program
that includes filters, layers and a host of goodies.
• F-Spot image manager for categorizing and minor editing of all of your pictures as well as easily
importing pictures from your digital camera.
• And much, MUCH more…
If Ubuntu doesn’t come with a particular application,
thousands of free applications are available from the
Ubuntu online repository which are easily installed and
updated from the Synaptic package manager.
When you decide to install Ubuntu onto your hard drive
or virtual machine you only need to click the ―Install‖
icon on the desktop to start the process. After seven or
so easy questions the installer will copy the files over to
the hard disk. Depending on your system’s speed this
could take about 60 minutes, more or less. It will even
detect if you have Windows installed and offer to transfer over your files and compatible settings from your
Windows accounts!
Of course, if you don’t like the limitations of the LiveCD,
such as settings are not saved from session to session,
and you are hesitant to partition and install the full operating system on your hard drive Ubuntu offers yet
another alternative called Wubi. Wubi is, from the Ubuntu website: ―Wubi is an officially supported Ubuntu
installer for Windows users that can bring you to the
Linux world with a single click. Wubi allows you to install and uninstall Ubuntu as any other Windows application, in a simple and safe way.
Are you curious about Linux and Ubuntu? Trying them

Ubuntu will scan your hardware and load the modules
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(Continued on page 9)
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(Continued from page 8) For Anyone Who Has Thought about Linux

out has never been easier!‖ Wubi can be downloaded
as an .exe file directly. With Linux the installation is not
the end, only the beginning! Whether you try the
LiveCD, Wubi or a full installation you will find a wealth
of quality applications, refreshing freedom and a community unlike any other! If you have problems, questions or want to find out more then you need look no
further than the third Wednesday of every month for the
DACS Linux SIG at 7:30 p.m. in the DACS Resource
Center in Connecticut!
Drew Kwashnak: Has been losing more nights of sleep
with Linux since 2002 and just can't keep from
downloading and trying the latest versions! When not
working with Linux he works with ASP.NET and Microsoft SQL Server for a small financial company. He is
also the DACS Linux SIG leader and a father of 3.
Links:
Ubuntu:
http://www.ubuntu.com
Get Ubuntu:
http://www.ubuntu.com/getubuntu
ShipIt:
https://shipit.ubuntu.com/
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

NEED HELP?—
Here’s Who to Contact:
Neil Higgins
440-967-9061 - higgins.neil@gmail.com
Evenings 6 p.m. -10 p.m. + Weekends
Hardware, Linux & Windows Operating Systems,
Tweaking your system

Micky Knickman
440-967-3118 - micky@knickman.com
Evenings 5 p.m. – 9 p.m. + Weekends
General Software Configuration, Hardware Installation,
Basic to Advanced Windows

Lou Koch
440-985-1585 - lkkoch@centurytel.net
Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, &
Outlook, Basic to Advanced Windows

Edie Lewandowski
440-282-4188 - elew@erienet.net
Daytime - midnight
Desktop Publishing, General File Management, Eudora Email,
MSWorks Tools,

Richard Barnett
440-365-9442 - Richard216@aol.com
Evenings & Weekends
General Software Configuration, HardwareInstallation, Basic to
Advanced Windows & Web Page Design

Sandee Ruth
440-984-2692 - sandee29@gmail.com
6 p.m. - 10 p.m. except when at work
Basic Word Processing, Windows, & Web Design
Advanced Internet

Jeff Kasler
440-967-7142 - Jeffk@roadrunner.com
10 a.m. - 7 p.m.
Burning CDs using Record Now

David Kennett

pcM.D.
● VIRUS REMOVAL ●
UPGRADES & REPAIRS
● NEW / USED COMPUTERS / PARTS ●

440-327-8624 - w8kfj@yahoo.com
9 a.m. - 8 p.m.
Video Editing & DVD Burning

Cathy Ratcliff
therats1@verizon.net
Though she lives in Coshocton, you can call
740-327-1483 before 8 pm
Paint Shop Pro, other Photo Editing programs,
Microsoft Office programs

SERVICE ON ANY COMPUTER MAKE AND
MODEL
CALL US WITH YOUR COMPUTER QUESTIONS!
FREE ESTIMATES!

440-365-2380
● THIS DR. MAKES HOUSE CALLS ●

405 Cleveland St., Elyria 44035
10% DISCOUNT TO
LCCUG MEMBERS!
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We have lost some of our members willing to take
calls. If you would like to help us out, add your name
to this list by contacting the Newsletter Editor
newsletter@LCCUG.com
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LCCUG O NGOING C LAS SES A ND W ORKS HOPS
A LL A RE F REE A ND O P EN T O T HE P UBLIC
Microsoft Digital Image
Date: Cancelled for the Summer
Time: 3:00 to 4:30 pm
Place: LCCC Learning Center
St. Joe’s Com. Center, 21st & Broadway
Cal l Di na Fer r er 366 - 4507 t o r egi s t er
Dial 0 if you can not get through on her number.
For Info contact Don Hall - secretary@lccug.com

Problem Solving Workshop
Date: Tuesday,
Time: 5:30 - 8 pm
Instructor: Micky Knickman, et al.
Place: Amherst Church of the Nazarene

210 Cooper Foster Park Rd.,44001
Learn how to repair or update your computer by changing hard drives, memory, CD ROMs, etc.
Members are encouraged to bring their computers anytime before 7:30 pm for assistance from Micky, Neil or other
knowledgeable members.

Digital Photography SIG
The LCCUG Photo SIG
Date: Tuesday August 19, 2008
Place: Lorain Public Main Library - 6th & Reid Ave.
Time: 7 - 8:20 pm
Sandee Ruth, President@lccug.com.
Check our blog for photo ideas in the meantime http://lccugphotosig.blogspot.com/

Genealogy Class
Date: Cancelled until September
Time: 5 - 7 pm
Instructor: Pam Rihel
Place: LCCC Learning Center.
St. Joe’s Com. Center, 21st & Broadway
Learn more about finding your ancestors with public
records & online websites. How to start & sources to use.
To register,
Email: LadyGeneo@roadrunner.com
Phone: 440-277-6076

Ubuntu Linux
Date: Mondays, except Labor day
Time: 6:00 to 8:00 Pm
Place: Amherst Church of the Nazarene

210 Cooper Foster Park Rd.,44001
Instructor: Neil Higgins
Learn all about using Ubuntu Linux Operating system

All Senior Center Classes
Date: Cancelled for Summer
Time: various times
Place: Lorain Senior Center
3360 Garfield Blvd.
Instructor: Sandy Strong & Mavle Green
Variety of classes for Seniors: Computer 1 & 2,
Keyboarding and Review

Leslie Ennis
And Ron Dix

LCCUG
Web Site
Provider

Winners of the
$50.00 Raffle
Prizes
LCCUG
Picnic

www.erienet.net
Phone: (440) 960-5300
Volume 20 Issue 8| Page 10
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August 2008 Classes
Class Type

Location

Registration

August

Time

More Info

Classes / Workshops
Problem Solving
Micky Knickman

Amherst
Church of the Nazarene Not Required
210 Cooper Foster Park

Linux
Neil Higgins

Amherst
Church of the Nazarene
210 Cooper Foster Park

Higgins.neil
@gmail.com

Digital Imaging SIG
Don Hall

LCCC Learning Center
St. Joe’s Com. Center
21st & Broadway

Secretary
@lccug.com or
440-366-4507

Cancelled
For The Summer

Genealogy Class
Online & Off
Pam Rihel

LCCC Learning Center
St. Joe’s Com. Center
21st & Broadway

Reg. required
LadyGeneo @
roadrunner.com

Cancelled
Until September

All Sr Center Classes
Sandy Strong
Mavle Green

Lorain Senior Center
3360 Garfield Blvd.

440-288-4040

Digital Photos
& Graphics SIG
Sandee Ruth

Lorain Public Library
6th & Reid

Cancelled
For August
Every Monday
Except Sept 1st

6 - 8 pm

Page
10

Cancelled
For The Summer

440-244-1192
or 1-800-322- August 19, 2008
READ x272

7 - 8:20 pm

Page
10

Readers’ Tips

with the chemical composition of their brands of ink. When
I started using HP paper, the same pictures printed out
perfectly.

Stay Organized & Get The Most Out Of Your Printer

Jayson V., Hollywood, Calif.

Don’t Change That Cartridge Yet
When the ―out of ink‖ indicator on your printer says you
need to replace your ink cartridge(s), ignore it and keep on
printing. You may find that the cartridge will continue to
produce quality documents. I have printed excellentquality photos and documents long after the indicator
suggested I replace my cartridges.

Quick URL Shortcuts
I do a lot of shopping online, and I like to compare products and prices. I have created a folder called Investigating on my Desktop. I can put shortcuts to each Web page
that I want to revisit by clicking the icon that appears before the URL in the Address bar and
then dragging it into
my Investigating folder.

- Annie M., Cresson, Pa

Use The Correct Photo Paper
I recommend only using your printer manufacturer’s own brand of photo paper with your
printer. I was having trouble printing quality
photos. I have an HP printer, and I tried just
buying any photo paper on sale—Canon, Epson, etc. My photos kept printing out with wrong
skin tones and were off-color, even though they looked
great on the screen. Then I read that manufacturers formulate their own brands of photo paper to perfectly react
August 2008| Interface

The browser window must be in midsized mode so that
you can view the folder, also. I find that it’s a lot easier and
more practical than adding pages to a Favorites list where
they can languish forever without ever being deleted.
Stanley B., Hollywood, Fla.
Reprinted with permission from Smart Computing.
Visit http://www.smartcomputing.com to learn what Smart Computing
can do for you and your user group!
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E-Mailing Photographs
By Richard Kennon, Editor, Amador Computer Users
Group, CA
www.acug.net
Drtrdguy(at)volcano.net
First, we must understand that photograph (image)
size in the camera and in the computer is measured in
pixels. These are the basic dots of color that make the
picture. Do not pay any attention to anything that says
―inches‖ or ―pixels per inch.‖ These terms are meaningless when we are considering a picture either in the
camera or in the computer. They may come into play
later if we want to print the photo on paper. But, that is
another subject for another time. For now, we think only
of pixels. Most cameras record too many pixels to email. For instance a 6 megapixel camera will make a
picture about 3000 pixels wide by 2000 pixels tall and
the file size may be several megabytes. Our screens
are usually only about 1000 pixels wide (some are larger and some smaller). So, if we e-mail the native picture, it will be wider than the screen for the recipient
and the file will be so large, it may take ―forever‖ to
download to the recipient’s computer. It is possible the
service provider will not even accept it.
There are two things we must do to make a photo emailable. The first is to resize or resample the picture.
We want to change the picture width from 3000 pixels
to 800 pixels, for instance. This process is called resizing or resampling. We have to pick the best 800 pixels
out of the 3000 to represent our photo. Well, no, that is
not exactly correct but it simplifies things to think of it
that way. We don’t have to worry about it because a lot
of very smart programmers have developed ways
(algorithms) to help us. Just remember, you want to
resize or resample to get the photo down to a size convenient for e-mailing. I usually use 800 pixels or 900
pixels width for pictures I attach to e-mails.

The second thing to do to make a photo e-mailable is
to save it in JPEG format (.jpg). That is a format that
reduces file size a lot and picture quality a little so the
picture can be downloaded more quickly and still be
nice to look at. Some software programs give you
choices of compression amount with numbers ranging
from 1 to 10. One will result in a very small file but the
picture quality will not be good at all. A 10 will give the
very best quality but with a very large file size. A reasonable compromise is to use 5 or 6. I usually use 6.
How do you do this? First, I will describe how to do it
with a free Microsoft program. Then I will try to look at
some other programs.
Microsoft Power Toys for XP has a Resize Pictures toy
that is slick and easy but feedback says it only works
on XP. It can be downloaded at http://www.microsoft.
com /windowsx p/ downloads/ powertoy s/
xppowertoys.mspx. Right click on an image name or
thumbnail in Explorer or My Computer and choose Resize Pictures. You are limited to four specific sizes but
they are good choices. They don’t tell us what compression they are using but the results look OK. Unless
you tell them under Advanced to replace the image in
the file, it will make a copy. That’s good. They will add
the word, ―Large‖, ―Medium‖ or ―Small‖ to the end of the
name you have chosen.
If you are happy with
this solution, then
read no further. But, if
you want to use a picture editing program,
maybe this will help.
In Photoshop Elements 5, click on Image>Resize>Image
Size and this window
will pop up. Note that
there is some garbage
at the bottom about ―inches‖ but we will ignore that.
First we will click the
Resample
Image
box. That puts the
Pixel Dimensions in
play and that is what
we want. I selected
the Width box and
changed the width to
800 pixels. Since the
Constrain Proportions box is selected, that is all I
have to do.
Note, down at the
bottom, that we have
several choices of
(Continued on page 13)
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(Continued from page 12) E-mailing Photographs

sampling algorithms. This is frosting on the cake. I read
somewhere that I should use Bicubic Sharper when
downsizing so that is what I do. Most programs don’t
give us all these choices. Then we should click on
File>Save As and give the photo a new name. I often
just use the same name and add ―_800px‖ so the next
time I will know it is ready to e-mail. Here we can
choose the JPEG format and the compression amount.
Photoshop Elements 6 is out now and sells for about
$100. If you are
able to spend that
much and want one
of the best editing
programs, I highly
recommend it.
Let’s look at Picasa2. It is a free
program
f rom
Google and looks
really good but I do
not have much experience with it. By
all means, try it first
because the price is
right!
When
it
comes to e-mailing
photographs, it is a
little more automated but not any easier to use than
Elements. First, click on Tools>Options>E-Mail. Then
select the width you want in pixels. There are six
choices.
Then
click on Apply
and OK.
The next step is
to click on File>EMail and you will
get three choices
of how you want
to e-mail your
photos.
Fortunately, I use Outlook Express so
my
choice
is
listed.
When I clicked on Outlook Express, an e-mail page
popped up with the photo attached. At this point we can
write something else on the e-mail and send it. I recommend this so the recipient will know it is really from you
and not something sent out by a virus. When I receive
e-mails that only say ―Attached‖, I Delete them without
looking at the attachment. This saved me one time
when I received a virus from my sister-in-law that she
did not know she sent. She spent weeks and dollars
getting her computer back up. Oh, I digress. If you want
to send more than one picture (and, who doesn’t?), you
must select the picture and click on the Hold button
August 2008| Interface

near the bottom of the screen. Do this for each photo
you want to send and they will all be attached to the email. The program automatically chooses JPEG format
and a compression ratio but does not tell you. That is
OK as the pictures I tried looked good. Picasa2 has
considerable capability for editing photos in many respects. Try it!
There are many other editing programs that I haven’t
mentioned and have no experience with. In all cases
you want to change the picture’s size in pixels by resizing or resampling. Pay no attention to anything that
says ―inches‖ as that will have no meaning for this process. Sometime later we will talk about printing pictures
and then we will use inches.
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

2008
LCCUG
Club
Picnic

On Sunday July 20th we had our annual picnic.
The food was great and everyone had a great time.
The winners of the $50.00 raffle were, Leslie Ennis
and Ron Dix (see picture on page 10.) 32 adults
and one child showed up. The rains held off and the
sun came out. All in all it was a great day for a picnic.
Sandee Ruth and Keith Kuhn brought the games,
Corn Hole, Horse Shoes, Bulls Eye Washers and
Ladder Golf.
Prizes we donated by the Club, Jean Griffith, Pam
Rihel and Ken Ritchey
The Hamburgers and Hot Dogs were cooked by
Micky Knickman (see picture above) and Lou Koch.

Stan
Lewandowski
(pictured to
the left)
looks to have
had his
share.
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The New, The Best, and
The Worst Spring 2008
Collected by Pim Borman, Webmaster, SW Indiana PC
Users Group

swipcug.apcug.org
swipcug(at)gmail.com
Tales of Woe
Sorry, Folks, I can't think of any New and/or Best to
report on, only Troubles, with a Capital 'T.' So let's get
started.

Spinrite 6.
Son Mike's computer recently refused to
boot, and his main concern was the potential loss of some recent data files that
he had not yet backed up. Regrettable,
but it happens to the best of us - literally. The local
school system lost all the students' test results of the
current term because the computers crashed. The data
were not securely backed up. Whom to blame? No one
other than the operator, IBM, symbol of computing excellence. According to the local paper, the IBM representative claimed that this had never happened before
and could not be explained. Sound familiar?
Back to Mike. When it was clear that he could not boot
from the hard drive, not even in safe mode, the next
step was to use a Windows XP setup disc and use its
Repair function. Windows labored mightily, trying to
repair his drive, but kept getting bogged down with a
variety of obscure error messages. At one time he got a
DOS prompt that allowed him to list the files on his
computer, but when he tried to copy them he was denied access. When we booted his computer with a Live
Ubuntu Linux CD he could also see his precious files,
but access was again denied.
There is a lesson to be learned from this. The Windows
XP operating system runs on a partition configured in
the NTFS format. When data files are saved in that format, Windows XP (and Vista) by default protect those
files from access by others. That is a nice safety feature for those who really need it, but it makes the data
unavailable over your network, or evidently even from a
DOS prompt. You can beforehand designate specific
data files to be shared, but it is a lot of bother, easily
forgotten. Here is the lesson: store all your data files on
a separate partition set up in the older FAT32 format,
and they'll be available whenever and wherever you
need them. Even better, also back them up to an external drive in FAT32 format.
Volume 20 Issue 8| Page 14

At this point I remembered reading about a terrific file
recovery program, Spinrite 6, available for $89 from
Gibson Research Corporation, owned and operated by
Steve Gibson, the well-known computer guru
(www.grc.com). We downloaded the program and converted it to a bootable disc. After booting Mike's computer with the Spinrite disc it immediately announced
that his drive was subject to imminent failure. Well,
that's what we spent the $89 for. We started the file
recovery mode, with a warning that this could take a
looong time, think 24 hours or so.
Several days later, after running something like 60
hours during which the program every so often would
get bogged down and had to be restarted, the program
had progressed to 93% completion and refused to go
any further. No indication that any files were available
to be recovered.
Mike installed Windows XP on a new drive and put the
old wreck in an external hard drive enclosure connected to a USB port of his computer. The old drive
was unreadable at this point. Still unwilling to give up,
Mike tried the old standby, Windows' checkdisk with
the /F parameter (for "fix") to let Windows try to repair
salvageable parts of the drive. It worked! After several
repeats of the procedure he was able to recover most
of his lost files that meanwhile also had become accessible. So much for Spinrite, mark one up for good old
DOS.

Acronis
After creating the Spinrite disc,
and before using it on Mike's computer, I tested it on my desktop
computer by doing a routine check
of my hard drive, expecting it to be in perfect shape. To
my surprise Spinrite halted about 5% into the inspection because the hard drive was overheating. Newer
serial (SATA) hard drives are equipped with a SMART
program that reports many operating parameters of the
drive. Windows can't read SMART, but Spinrite can. On
inspection I found that the cooling fan for the hard drive
compartment was kaput. It was easily replaced by the
local people who built my computer, but even then the
drive continued to overheat, a clear warning that it may
fail any time.
I bought a new 500 GB Maxtor drive (on sale for $99!)
which came with a utility, "MaxBlast" to copy an exact
image of my setup to the new disc, avoiding the necessity to reinstall everything. The way it wanted to go
about it was to do a three--way partition of the 500 MB
drive, similar to the 3 partitions in the old (250 MB)
drive, but twice as large. It was going to copy everything on the old drive to the new drive, including my
Linux programs in their partition, with the warning that
(Continued on page 15)
August 2008 | Interface

(Continued from page 14) The New, The Best, The Worst….

the Linux system would no longer be bootable. That
was not what I had in mind, I just wanted to copy an
image of the C: partition from the old to the new drive.
Since MaxBlast turned out to be version 10 of disk
manager Acronis, I gave Acronis-11 a try in the hope
that it would be more flexible. I uninstalled MaxBlast
and tried to install Acronis 11, but it balked. I tried to
remove all traces of MaxBlast from the Registry, but
Acronis still wouldn't install. I uninstalled as much as
possible of Acronis and tried to reinstall MaxBlast. No
luck; darn. So much for Acronis.
After clean installations of Windows XP and Ubuntu
Linux on the new drive, Windows could not find my
Internet connection. After struggling several days I finally realized that my motherboard needed to be software-configured and that I did not have the correct drivers. Thanks to the local availability of the guys who
originally built the system I got the correct drivers and
all was well. Ubuntu never had any problem. It
downloaded and installed the required Linux drivers
automatically.

Ubuntu
Windows Vista is not the
only operating system with
compatibility problems on
installation. Ubuntu and
other Linux distributions have more than their share of
installation problems. Most of these appear to be due
to proprietary graphics systems for which Linux has no
drivers (yet). I have been recommending for years that
people ought to start using Linux, but on both occasions where I convinced someone, it turned out that
Ubuntu was incompatible with their systems. Computers with integrated graphics and many laptop computers have low-cost proprietary hardware (made in
China) that is attuned to Windows, but unlikely to have
Linux drivers. Standard graphics cards from major
manufacturers are more likely to have Linux drivers
available, and those based on the NVidea chip set
have Linux support from the manufacturer.
You can try to run Ubuntu from the CD-ROM without
installing it on the hard drive, a so-called "live" installation. If that works, your system is probably compatible
and you can proceed with a permanent installation. If it
doesn't work, not much is lost since the distribution is
free. In any case, Linux is a large program and requires
at least 256 MB of RAM and 10 GB of hard drive
space.
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

Email Archiving
Genie Archive For Outlook 2.0
Reviews
August 2008 • Vol.19 Issue 8
Page 25 in print issue

$34.95; Free trial
Genie-Soft
sales@genie-soft.com
www.genie-soft.com
Key Benefits:
• Automates and expands upon Outlook’s archival capabilities

If you’re an Outlook user, you may have discovered
that the program’s personal folders can become corrupt
at far smaller sizes than the theoretical maximums. Furthermore, finding messages in a packed inbox can be a
crapshoot. If you store many messages, Genie Archive
For Outlook might be your ticket to sanity. (NOTE: Genie also offers a free backup product for Outlook Express, not reviewed here.)
Genie Archive For Outlook monitors your email folders
and moves messages to an archive on an ongoing basis. It can delete messages from the archive as you
move their local counterparts to the Deleted Items or
Junk Mail folders, and/or it can delete items after it copies them to the archive. It can also encrypt and password-protect your archives.
After installation, Genie Archive For Outlook adds a
toolbar to your Outlook interface where you can adjust
archive options. It also adds a Search box that lets you
search the archive for emails. Type a keyword in the
box and press ENTER, or click the Search button and
the program will open a Web-based search interface.
The program also has a Timeline feature that lets you
view emails chronologically or within date ranges.
Genie Archive For Outlook is not the most full-featured
Outlook backup program. However, it is a handy, set-itand-forget-it utility that can organize and protect your
messages without affecting Outlook’s performance.
by Jennifer Farwell
Reprinted with permission from Smart Computing.
Visit http://www.smartcomputing.com
to learn what Smart Computing can do for you and your user group!
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Your Next Computer
Will Be Green
By Marjie Tucker, Editor, Mountain Computer User
Group, GA
www.mcug.org
mcug(at)dnet.net
With Europe leading the way, the computer industry is
decidedly becoming "green." The Waste Electrical and
Electronic Equipment (WEEE) and the Restriction of
Hazardous Substances (ROHS) directives went into
effect earlier this year. These two directives state that
certain electrical and electronic equipment must cut
down on hazardous materials such as lead, mercury,
and cadmium. They also give customers the right to
return their equipment free of charge. Companies have
several years to fully implement these directives, but
the leaders have already started to make changes.
Dell, for example, is advertising Energy Smart workstations and notebooks that can reduce power consumption by as much as 78%. The Energy Smart configuration uses a default power setting that is designed to
reduce consumption and energy costs right out of the
box. In addition, the power supply, fan, and motherboard use significantly less energy to maintain cool
internal temperatures.
HP is using 80 Plus power supplies to lower energy
bills and AMD technology that reduces heat output and
PC power consumption. In addition, they have already
introduced an HP recycling program where you can
trade-in or donate the products.
Government Initiatives
Many U.S. government agencies have implemented
standards and regulations to encourage green computing. The Environmental Protection Agency launched an
Energy Star program in 1992 and strengthened its requirements in 2006. In 2003 the California State Senate enacted the Electronic Waste Recycling Act and in
2007 President Bush issued Executive Order 13423
requiring all federal agencies to use the Electronic
Products Environmental Assessment Tool when purchasing computer systems. In addition, a global consortium called The Green Grid was founded in 2007 by
AMD, APC, Dell, HP, IBM, Intel, Microsoft, Rackable
Systems, SprayCool, Sun and VMware.
Another initiative formed by a group of Global-minded
IT executives, the Green Computing Impact Organization (GCIO), was created to be an active participant in
transforming the IT community from an environmental
liability to an Earth conscious example of responsibility.
GCIO is a nonprofit organization that is based on environmental audit programs for consumers and small
business homes with respect to general energyVolume 20 Issue 8| Page 16

efficiency programs (including lighting, heating, insulation, etc.). GCIO’s mission is to educate and assist enterprise technology users in the design of environmentally aware and responsible information system operations. They help consumers become more environmentally responsible by reducing energy consumption and
electronic waste in an effort to protect the Earth.
GCIO is sponsoring educational programs across the
country and participating in a Green Computing Summit
that will be held in Washington, DC on May 20th. The
summit will address how public sector IT managers,
procurement officials, and program managers public
sector professionals can transform their IT and data
center operations into more environmentally conscious
yet efficient solutions. This conference will attract senior government IT professionals and their industry partners tasked with helping agencies become greener in
the coming years. Attendees will represent federal,
state and local governments, public policy organizations and suppliers to government. You can read more
about this event at www.e-gov.com/EventOver
view.aspx?Event=SGCS08 .
Features of Green Computing
Power management is the most popular method. The
operating system of the computer can be set to directly
control the power saving aspects of the hardware. It
can automatically turn off the monitor or hard drive after
a period of inactivity. Or, the entire system may hibernate, turning off most of the components such as even
allowing the user to manually adjust the voltages supplied to the CPU to reduce the electricity consumption
and the amount of heat that is produced. As of July of
2007, all new Energy Star certified desktops must have
a power supply that is at least 80% efficient.
Other features include using motherboard video output
instead of a video card, hard disks that consume less
power, flash based solid state drives that require fewer
write cycles, and lower energy monitors. And, manufacturers of networking equipment are developing
switches and routers that reduce energy costs.
Recycling Materials
Obsolete computers can be reused for charities, nonprofit organizations, and developing countries. Parts
from really old systems can be recycled through some
recycling centers. Some recycling charges can be
passed back to the manufacturers.
Recycling this equipment keeps the lead, mercury, and
chromium out of our landfills. In addition, computer supplies such as cartridges, paper, and batteries can be
easily recycled.
How Can We Work Greener?
Visit the website for Climate Savers Smart Computing
at sww.climatesaverscomputing.org to view a three
step program to go green. Here are the basic steps that
(Continued on page 17)
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they suggest:
Step One - Turn on Power Management. Since the
average desktop PC wastes nearly 50% of the energy
it consumes as heat, it makes sense to use the power
management features that are built into Windows XP
and Vista. The benefits? You will reduce your electricity
bills and your energy footprint will be lowered as you
reduce your greenhouse gas emissions. The Climate
Savers organization predicts that the power management features on your computer can save nearly half a
ton of CO2 and more than $60 a year in energy costs.
Step Two - Buy an energy efficient computer. Energy
Star, the program designed by the U.S. Environmental
Protection Agency, specifies the standards that equipment and appliances must meet to wear the Energy
Star badge. You can visit their website at
www.energystar.org for specifics. Basically an Energy
Star compliant PC uses 15 to 25 percent less energy.
This program is expected to save U.S. consumers andbusinesses more than $1.8 billion in energy costs over
the next five years and prevent greenhouse gas emission equal to 2.7 million vehicles.
Step Three – Unplug from phantom power. As long as
your computer is plugged in it still uses electricity, even
while it is turned off or in standby mode. A computer
that is turned off, but still plugged in, can use up to 10
watts. The Climate Savers estimate that you can reduce your electricity bills by as much as 10% by unplugging your appliances and electronics when they're
not being used.

Special
Thanks
to those at the Murray Ridge
Production Center in Lorain, a
worksite of the Lorain County Board of Mental
Retardation, for collating, folding, and stapling our
newsletter. If any other organizations or businesses would like to acquire their help, contact
them at (440) 284-2720 or www.mrpcinc.com.
Newsletter Editor: Pam Rihel using Microsoft Publisher, Corel
Paint Shop Pro X & American Greetings CreataCard
This Month’s contributors: Micky Knickman, Lou Koch, Edie
Lewandowski, Sandra Ruth, Kaye Coller, Don Hall, Ken Ritchey,
Richard Kennon, Drew Kwashnak, Ira Wilsker, Pim Borman,
Jennifer Farwell, Trevor Meers, Marjie Tucker, Smart Computing
Magazine, APCUG, and Microsoft Office art online.

Easy Web Site
Editing
EZGenerator
by Jennifer Farwell
Would-be Web site builders who strain at the limitations
of free online Web tools but don’t want the hassle of
learning
HTML
(Hypertext Markup
Language) coding
may love EZGenerator. Its price
places it a bit
$129; Free trial
above some comImage Line Software
petitors. However,
info@image-line.com
its ease-of-use and
www.ezgenerator.com
broad functionality
Key Features:
may compensate
• Highly automated Web site generator
for the price, de• Extensive collection of ready-made
pending on your
templates.
needs.
Installation is a snap, and the program provides both a
sample site and a functional site-creation wizard to get
you started. Finishing your site once you run the wizard
can be as basic as keying text to replace the placeholder copy and uploading the site, or you can enhance
the project by replacing images, adding flash,
and making other adaptations.
The interface is fully WYSIWYG (what you see is what
you get—graphic rather than HTML code views) with
menus and button bars that afford access to formatting
options, SEO (search engine optimization) setup, and
more. A central window shows the working page, while
a side pane displays the site's organizational structure.
When you are finished, a temporary "test account" lets
you see how your site will perform online prior to live
upload via FTP (File Transfer Protocol—talk to your
Web host about this).
EZGenerator misses the mark in a few places, though.
There is no way to search the thousands of templates
by theme, category, or even color scheme. Furthermore, Web design can be complex business, and fully
utilizing the features of EZGenerator takes skill and
time. For code-challenged Web builders who want an
advanced site, this is not a bad choice. If your final site
will be basic, however, there are less expensive ways
to make the journey.
Reprinted with permission from Smart Computing.
Visit http://www.smartcomputing.com to learn what Smart Computing
can do for you and your user group!

Printing Done In House
Assembly Done By:
Murray Ridge Production Center of Lorain, OH.
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tion lets you search through values displayed in cells, formulas behind the cells, or comments attached to cells. These are
seldom-used options.

Excel 2007
How To Find Almost Anything
by Trevor Meers
Your worksheets don’t have to get very big before you start
wishing for a better way to find things than scrolling around
and hunting for them. Read on to learn about Excel’s methods for taking you directly to the information you seek.
In the Home tab’s Editing group, select Find & Select for
almost a dozen options for finding information based on
what it contains, what it looks like, or how it behaves.
Basic Find Jobs

Send In Replacements
The Replace tab of the Find And Replace dialog box shares
most of the Find tab’s options. But, as you might guess, it
includes a Replace option, which is pretty self-explanatory.
Excel looks for whatever you put in the Find What box and
swaps it for what you put in the Replace With box.
Remember a couple of tips, though. Click Replace to replace
only the next occurrence of the info in the Find What box.
Click Replace All to change every occurrence in the worksheet or workbook. To delete all occurrences of a certain
string, enter it in the Find What box, leave the Replace With
box blank, and click Replace All.
Find Other Types Of Content

Let’s start simply: looking for one piece of information such
as the sales quota for Steve Dinero in a large worksheet.
Click Find & Select and Find to open the Find And Replace
dialog box. Type Steve Dinero into the Find What box and
click Find All. This automatically selects the first cell Excel
finds containing that text and lists all cells containing the
text. To move the selected cell to the next one containing the
text, click Find Next. To back up, hold down the SHIFT key
while clicking Find Next.
Find Options
Searches get more powerful when you click Options in the
dialog box. The Format button lets you search for only data
that matches your target string and the selected formatting.
Let’s say you want to find all products priced at $1,999 in
the spreadsheet. If you select Currency formatting, Excel
skips over the year 1999, for example. You also can search
by Format alone, telling Excel, for example, to locate all
cells formatted as Currency. After a search, open the Find
Format dialog box and click Clear. Otherwise, the format
search remains in effect and could confuse your next search.

The Find & Select button includes a few tools for jumping to
specific kinds of content. The ones you’re most likely to use
involve comments, formulas, and conditional formatting.
Excel adds a little triangle flag to cells containing comments,
but for an overview of all cells holding comments, click
Comments under Find & Select. Similarly, the Formulas
choice helps you spot which cells are data and which contain
formulas.
Conditional formatting changes a cell’s look, depending on
the info it contains. You may, for example, set up negative
figures to appear in red. Finding these cells can be hard as
you can’t see the formatting unless the data meets your conditions. To find them, click Conditional Formatting.
Reprinted with permission from Smart Computing.
Visit http://www.smartcomputing.com to learn what Smart Computing
can do for you and your user group!

A variety of Find options lets you locate specific kinds of
content, including data that carries the kind of formatting you
indicate.
Next, you can expand the search from the default setting of
the worksheet you’re
currently in to searching through the entire
workbook.

A variety of Find options lets you
locate specific kinds of content, including data that carries the kind of
formatting you indicate.
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The Search drop-down
list handles searches
where you specifically
want Excel to look for
the next occurrence of
the target in the current
row or the current column. The Look In opAugust 2008 | Interface

Tip Of The Day: July 17, 2008

Tip Of The Day: July 11, 2008 Email This

Keep It Clean
For best scan quality, you should clean the glass bed of your
scanner before every scan, but most people don't have the
patience to be that conscientious. If you're careful and you
don't allow anything other than a clean original to contact the
glass, you can probably get away with cleaning it less frequently.
When you do clean your scanner's bed, though, it's important
to use the right cleaner. Check with your scanner's manufacturer for specific recommendations or warnings. Generally
speaking, it's best to use a soft, lint-free, grit-free cloth; the
chamois used for cleaning camera lenses is a good choice.
Don't use paper towels because they can contain small
amounts of grit in the fibers. HP recommends using a window cleaner that doesn't contain ammonia; Microtek believes
pure alcohol is the best choice. Don't use rubbing alcohol
because it can contain lanolin and other ingredients. Instead,
use denatured alcohol, available at paint and hardware stores.
Be sure to check your work as you clean. After cleaning the
glass, raise or remove the scanner lid and perform a scan
with nothing on the glass. You should get a completely black
image. Haze or streaks indicate areas that need more cleaning. Sharp white spots may be dust or electronic noise. Noise
is random and won't appear in the same place in subsequent
scans; dust usually stays put.
And finally, clean only the outside surface of the glass bed;
don't remove the bed or attempt to access or clean any of the
mirrors or other optics inside the scanner.

GPS Devices
When shopping for a GPS (global positioning system), keep
in mind that different GPS models have different ways of
providing spoken directions to the user. One option is text-to
speech, which provides you with precise, spoken directions,
such as "In one block, turn right on Claire Street." Text-tospeech is particularly helpful if you're driving in unfamiliar
areas or with potential distractions because the detailed directions enable you to keep your eyes safely on the road
without needing to refer to the GPS' map for street names.
Turn-by-turn, on the other hand, offers simplified directions,
such as "Turn left in 200 feet," that are spoken when you
reach pivotal points in your route. GPS devices with turn-byturn directions are great if you can navigate with fewer directions or are budget-conscious and don't want to spend more
for a GPS with text-to-speech.

Tip Of The Day: July 16, 2008

Check For New Drivers
You can use Windows Update in Windows Vista to check
for newer versions of device drivers. Select Start, All Programs, and then Windows Update. In the left pane of the
Windows Update window, click Check for Updates. When
the search is complete, click the View Available Updates
link. If any new drivers are available, they will be listed. To
install a new driver, place a check mark next to the driver
and then click Install.
Tip Of The Day: July 12, 2008

Cell Phone Plans
If you're looking for a new cell phone service provider, it's
also a good time to look for a new cell phone. Most companies offer deep discounts on new cell phones when you sign
a contract with them. Although we don't recommend basing
your decision on a service provider solely on the phones
available, remember that some phones are only offered
through one company. Shop around for several models you
like and compare service plan options among the companies
that offer those models.

Tip Of The Day: June 24, 2008

Camera Battery Life
Whether it's a family picnic, climbing Pike's Peak, or an alltoo-rare moment of sibling togetherness, dead batteries can
kill a photo shoot. To avoid that awful sinking feeling, always carry spare, charged batteries, as well as your camera's
AC adapter. Your flash and LCD (liquid-crystal display) eat
up batteries, so shut them off when you're not using them.
Fun Facts & Stats Of The Day: July 17, 2008

New Technology Lets You Find The Cool Places In Town
A new tracking software service created by computer science
professor Tony Jebara tracks the signals from thousands of
GPS (global positioning system)-equipped mobile phones,
vehicles, and other data devices to locate where people are
gathering. Besides tracking group movement, the software
may also be useful for showing the most common routes.
Fun Site Of The Day July 17, 2008

The Budget Casa
With the economy slumping and gas prices hitting record
highs, almost all households are looking for ways to cut
down on cost s. At Th e Budget Ca sa
(www.thebudgetcasa.com), you can pick up tips on how to
enjoy life on a budget. This site includes decorating tips, doit-yourself projects, ideas for entertaining on a budget, and
more. Additionally, this site has tips for gardening and how
to use homegrown plants to cut down on your grocery shopping. http://www.thebudgetcasa.com

Reprinted with permission from Smart Computing.
Visit http://www.smartcomputing.com to learn what Smart Computing can do for you and your user group!
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Various LCCUG Meeting Locations

Gould Auditorium
All General Meetings are held at Gould
Auditorium - St Joseph Community Center,
Lorain, OH.
Park in the parking garage attached to the
building. Go west at the corner of Broadway and
W 21st St to the next block, Reid Ave., turn north
and the entrance for our parking is on the west
side of the garage.
Go up the ramp and park anywhere on the
2nd floor and up. Use the elevators to go to the
2nd floor, which opens to Gould Auditorium.
Note: Parking on the South, W. 21st St side
is only for the Emergency Vehicles.
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